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Measurements with Room EQ Wizard 

Measurement gear 

 Microphone with calibration file 

 Soundcard with 2 analog input channels. Left input for mic and right input from output of soundcard. Analog 

output (left) to amplifier to driver under test. 

 Room EQ Wizard V5.20 Beta 7 or later. Current version while writing this document: V5.20 Beta 13. 

 Computer with Windows, macOS or Linux, cables etc. 

 Manual turning table. 

Note! Single channel measurement systems such as USB microphones with latency variations by default are not 

recommended for speaker engineering due to timing and phase variations and normalizations. REW should not be 

used with single channel connection or mode for far field measurements because timing is normalized by the 

program. Single channel connection and mode is acceptable for near field measurements only. 

Impedance measurements 

1) Measure impedance response with phase of one woofer if all drivers have own box. If drivers share the same box 

volume, they should be measured together in series or parallel - like in the final connection. 

2) Measure impedance response of one mid-range driver if all drivers have own box. If drivers share the same box 

volume, they should be measured together in series or parallel - like in the final connection. 

3) Measure impedance response of tweeter. 

Measurement connection, copied from REW Help: 

 

REW Help, Impedance Measurement: 

Good results can be obtained using a headphone output to drive the load, with a 100 ohm sense resistor. If a line 

output is used the sense resistor typically needs to be larger as line outputs have high output impedance and limited 

drive capability, try 1 kOhm but note that the results will have much higher noise levels. 

An alternative is to drive the load via a power amplifier, which can deliver the lowest noise levels and most accurate 

results, but great care must be taken as the levels a power amplifier can generate can easily damage soundcard 

inputs. If using a power amplifier the sense resistor can be much lower, 33 ohms or less, but the soundcard inputs 

should be connected via a resistive divider providing around 20dB of attenuation and ideally the inputs should also be 

protected by back-to-back zener diodes to clamp the input to less than 5V. 

You can also use different gear and software such as DATS (Dayton Audio Test System). 



Gear setup for acoustical measurements 

Set up measurement gear for semi-dual channel acoustical measurement. 

Semi-dual channel connection: 

 

Typically microphone input of soundcard includes preamplifier and 48 V phantom power supply so external 

preamplifier is not needed. 

Right and left should be swapped with soundcards having phantom power only in the right channel. 

Start REW and open Preferences. Select Soundcard Driver, Sample Rate=88.2 kHz, Device, Outputs and Inputs. 

Calibrate Soundcard and load calibration file. See REW Help for more information. 

Example with Focusrite Scarlett 2i2: 

 

Load microphone calibration file. Example with Sonarworks XREF 20: 

 

Set default settings for IR windows in Analysis tab: 

 

Prepare manual turning table with angle scale -180…+180 deg, steps 10 deg. Diameter 80…120 cm depending on 

speaker size. This makes measuring process easy and fast. 



Terminology 

Few terms need to be defined first: 

 X-axis is horizontal from left (-) to right (+) when observer is in front of speaker. 

 Y-axis is vertical from floor (-) to ceiling (+). 

 Z-axis is horizontal from microphone (-) through the speaker to front wall (+) when measuring axial response 

0 degrees hor & ver. 

 

Rotation: Horizontal plane (top view) Vertical plane (left view) 

  

  



Far field measurements 

Remove all measurements from the list. 

Open Make a measurement window (Measure button or Tools->Measure or Ctrl+M). 

 
Settings: 

Type: SPL 

Name: Root filename; driver’s (short) name and measurement plane hor or ver, e.g. 

  M15CH002 hor 

Select Add number radio button. Open numbering setup window with dialog icon/button on the right. Set 

Next number to the 1st off-axis angle to be measured, and Increment to angle step of measurement sequence. 

Examples: 

* 0…+180 deg with step of 10 deg: Next number=0, Increment 10 

* 0…+90 deg with step of 10 deg: Next number=0, Increment 10 

* -170…+180 deg with step of 10 deg: Next number=-170, Increment 10 

* -90…+90 deg with step of 10 deg: Next number=-90, Increment 10 

Sample Rate: 88.2 kHz 

Range: 5…41000 Hz (to avoid extrapolation of response files in VituixCAD) 

Level: -10 dBFS 

Method: Sweep 

Length: 1 M (11.9 s) 

Repetitions: 1 

Timing: Use loopback as timing reference 

Timing offset: 2.907 ms (with 1000 mm measurement distance from mic to rotation center). 

Playback from: REW 

  



Measure far field responses of one woofer and one mid-range driver and tweeter at 1000 mm in horizontal plane 

around the speaker. To single side 0, 10, 20, …, 180 degrees if speaker is horizontally symmetrical. Very asymmetrical 

constructions such as classic 3-way should be measured both negative (to left) and positive (to right) off-axis 

angles: -170, -160, …, 0, …, +170, +180 degrees. Wall speakers should be measured and simulated to half space 0…90 

deg (see VituixCAD Options). Also full range horn speakers can be measured to half space only. Angle step could be 5 

degrees within listening window to get more accurate average e.g. radiators having dense on-axis response 

variations. 

Basic rules: 

 All far field measurements must have the same signal level from power amplifier. Amplifier volume, 

microphone sensitivity and other volume potentiometers should not be touched between measurements of 

different drivers. 

 1st order reflections should be avoided or delayed. Measure drivers at elevation of 110…125 cm (close to 

half of room height). Upper mid-range driver and 3rd woofer from the floor with WWMTMWW to get 

maximum possible distance for floor and ceiling reflections. Absorb with large and soft pillows on the floor 

and ceiling if possible to enable time windows longer than 4 ms. >150 cm from rotation center to walls. 

 Measurement description should have valid coding for plane and off-axis angle. 

<driver-name> <plane> <angle> where <plane> is hor or ver and <angle> is off-axis angle in degrees is 

recommended for VituixCAD. 

For example M15CH002 hor 110 equals M15CH002 to +110 degrees off-axis (to right) in horizontal plane. 

Single axial measurement (without off-axis responses) should also have plane and angle coding with “ hor 0”. 

 Elevation of mic is at the center point of driver under test i.e. mic and driver have the same Y-coordinate in 

mm. Turn speaker back/front if front baffle is tilted. 

Exception 1: Mid and tweeter can be measured at common mic elevation = average Y of center points if 

drivers are small and close to each other, baffle is straight (non-stepped) and vertical plane is not measured 

i.e. drivers are circular and hor/ver difference in baffle diffraction is ignored on purpose. 

 Rotation center on X-axis while off-axis measurement sequence is at the center point of driver under test. 

 Rotation center on Z-axis while off-axis measurement sequence: 

a) Rotation center on Z-axis is common for all drivers if drivers are installed in straight non-stepped 

baffle. Rotation center is typically on surface of front baffle for the tweeter. Z=0 mm for all drivers in 

crossover simulation regardless of difference between baffle surface and acoustical center. 

b) Rotation center on Z-axis varies with stepped baffle. Drivers on each baffle level has own rotation 

center on Z-axis. Distance from each baffle level to microphone must be constant (1000 mm). 

Differences on Z-axis are entered to the simulator as Z mm of the driver, e.g. tweeter Z=0 mm, 

mid-range Z=-20 mm, woofer Z=-100 mm. 

 All drivers should be measured to same off-axis angles. Also subwoofers if they are included in the same 

construction, and power response and DI are simulated with the other drivers. 

 Unsymmetrical rectangular radiators such as AMTs and ribbons as well as elliptical and rectangular horns 

with height <> width must be measured in both planes. 

 If vertical plane is measured, off-axis angles in vertical plane must be equal to horizontal plane to avoid 

mirroring from horizontal to vertical and vice versa. 

Measurement of vertical plane can be skipped if the driver and possible wave guide/horn are circular i.e. 

directivity in vertical plane is equal to horizontal plane. Skipping of vertical plane could cause small hump (< 

1 dB) to power response at diffraction peak frequency if baffle height is much longer than width. In that case 

sound balancing should be weighted by axial response around diffraction peak frequency (wave length = baffle 

width). 

Verify with SPL graph that all far field measurements are okay. Save all measurements of one driver to single 

mdat file. 

  



For information: Phase response of dual channel measurement includes difference between rotation center and 

actual acoustical center of driver. Phase response includes also extra travel distance from radiator's throat via 

possible wave guide/horn and around box edges including delayed diffractions when speaker is rotated >90 deg 

while off-axis measurement sequence. 

Note! Z difference between rotation center (on baffle surface) and actual acoustical center of driver should never 

be entered to Z mm coordinate of driver instance in crossover simulation with unidirectional drivers such as boxed 

speakers and horns to avoid geometry calculation error which would cause immediate response summing error 

to off-axis directions. Z mm of all driver instances in crossover should be 0 mm with dual channel measurements 

described in this document. 

  



Near field measurements 

Remove all measurements from the list. 

Open Make a measurement window (Measure button or Tools->Measure or Ctrl+M). 

Settings are the same with far field measurements except: 

Name: Not formal. For example driver’s (short) name and ‘near’ and ‘cone’ or ‘vent’, 

M15CH002 near cone, L22RNXP near vent or SP22R near (passive is just cone) 

 Select Use as entered radio button 

Level: -30 dBFS 

Other possible differences: 

Timing: No timing reference 

 Select t=0 at IR start 

Do not touch volume controls of amplifier and microphone input by default. Decrease with volume potentiometer if 

mic input clips (red led flashes) when measuring reflex port or midrange driver at near field. 

Measure near field response of one woofer cone at 5 mm from center of dust cap. Measure at 5 mm from cone close 

to phase plug if the driver has phase plug. If two woofers have shared box, feed signal to both woofers and isolate 

(not brake) the other (which is not under test) gently with pillow to prevent midrange frequencies going to mic too 

much. 

Measure near field response of reflex port(s) or passive radiator(s). Mic in the center of vent at baffle surface if vent 

is not rounded. If vent has rounding, penetrate few millimeters inside, where tube with constant diameter begins. 

Not too deep. 

Measure near field response of one mid-range driver at 5 mm from center of dust cap. Measure at 5 mm from cone 

close to phase plug if the driver has phase plug. 

Verify with SPL graph that all near field measurements are okay. Save all measurements to single mdat file. 

Useful metadata with the measurements for VituixCAD operator 

 Drawing of front baffle; dimensions, driver locations, edge radius (locations specified if radius variates 

much). 

 Type of drivers, or at least Sd or Dd for magnitude scaling. 

 Dimensions and number of reflex ports or passive radiators. 

 Typical listening distance. 

 Room acoustics measurements. Measurement at listening position, from left and right channel separately, 

with common small 2-way or 3-way, sine sweep 1M, about 80 dB SPL. 

 Sketch of listening room dimensions and layout. Construction materials and location of possible acoustic 

panels and diffusers. 

Hired VituixCAD operator can do the rest. If you hire VituixCAD operator, zip all measurement files (.mdat) files and 

calibration files and metadata and send by e-mail. 

  



Example: WWMTMWW speaker with closed enclosures 

Exporting far field responses 

Export far field responses of tweeter 

Remove all measurements from the list. 

Open far field measurements of tweeter. Select axial response “ hor 0”. Select Impulse graph tab. Set Y-axis unit to 

%. Click IR windows button to adjust gating. Set Left window Tukey 0.25, length 2.0 ms. Right window Tukey 0.25. 

Adjust length so that time window ends in the beginning of the first reflection. Should be 3-5 ms. Click Apply 

Windows to All and Save mdat. 

 

Export frequency responses with File -> Export -> Export all measurements as text. Settings: 
  Use custom range: 5 to 40000 Hz 
  Use custom resolution: 48 PPO 
  Use smoothing of measurement:  1/24 octave
  Use REW export number format: 12345.6 
  Choose the export delimiter text: Tab 

 

Click OK and export to username\Documents\VituixCAD\Projects\projectname\Far -directory. 



Export far field responses of mid-range driver 

Remove all measurements from the list. 

Open far field measurements of mid-range driver. Select axial response “ hor 0”. Adjust time windows, Apply 

Windows To All, Save mdat and export response files with previous settings to 

username\Documents\VituixCAD\Projects\projectname\Far -directory. 

Export far field responses of woofer 

Remove all measurements from the list. 

Open far field measurements of woofer. Select axial response “ hor 0”. Adjust time windows, Apply Windows To All, 

Save mdat and and export response files with previous settings to 

username\Documents\VituixCAD\Projects\projectname\Far -directory. 

Exporting of near field responses 

Export near field response of woofers, ports, passive radiators and mid-range drivers 

Remove all measurements from the list. 

Open near field measurements. Select response of mid-range or woofer cone. Set Right window Tukey 0.25, length 

1000 ms. Click Apply Windows To All, Save mdat and and export response files with previous settings to 

username\Documents\VituixCAD\Projects\projectname\Near -directory. 

  



VituixCAD Options 
Verify that Number format of angle coding is compatible with your response files. Listening distance is your typical 

listening distance, but don’t set shorter 2500 mm. Check Mirror missing angles in Frequency responses group. Verify 

that parameters in Power response & DI Calculation group are the following (check also Half space with wall 

speakers, when measurements cover 0…90 deg only): 

 

  



Baffle diffraction simulation 

Simulate cabinet impact response of woofers 

Include woofers representing average of all woofers. Two woofers represent all four in this case. Set mic on lower 

woofer. See parameters below. Export cabinet impact response without directivity. 

 

Simulate cabinet impact response of midrange driver 

Include single driver if it represents all. Set mic in the center point. See parameters below. Export cabinet impact 

response without directivity. 

 

  



Merging of near and far field responses 

Merging of woofer responses 

Amplitude of near field responses (in Low frequency part) is adjusted manually with Scale [dB] until levels are equal 

within blending range, especially 300…600 Hz. Scaling is close to 0 dB if also near field responses were measured 

with (semi-)dual channel connection and dual channel mode. 

Delay [us] is set automatically while adjusting transition frequency. See other parameters below. Export merged 

responses with Save button. 

 

Merging of mid-range responses 

Amplitude of near field response is adjusted manually with Scale [dB] until levels are equal within blending range, 

especially 300…600 Hz. Scaling is close to 0 dB if also near field responses were measured with (semi-)dual channel 

connection and dual channel mode. 

Delay [us] is set automatically while adjusting transition frequency. See other parameters below. Export merged 

responses with Save button. 

 

Merger video lesson: 

https://www.youtube.com/watch?v=cUGDhpleWD0 

https://www.youtube.com/watch?v=cUGDhpleWD0

